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From The Chief Editor's Desk...
Both of my kids just competed in the annual Pinewood Derby race in their Cub Scout pack (Pack 4865, Heart of America Council, Independence, MO) on January 21. This was their third Pinewood Derby (even though my daughter wasn't an official Cub Scout for her first Derby, my son's pack allowed her to enter a car in the sibling category). This meant that dad had not the customary one car to build, but two cars. But, that's been the way it has been ever since we started racing in the Pinewood Derby.

They pick out the pattern and determine the color scheme. Dad cuts the cars out on the bandsaw (I actually went out and bought one for last year's Pinewood Derby). Then, all of us sit around filing and sanding the cars smooth. After the sanding, dad adjusts the weight of the cars to as close to five ounces as possible, without going over, by drilling holes and filling the holes with lead fishing weights. That's followed by more sanding of the wood putty used to hold the fishing weights in place. Then, my wife and each child sit down at the dining room table and paint the cars. Finally, it's dad's turn again to attach the wheels. But it's never that simple, since dad also polishes the "axles" (nails) by chucking the nails into the drill press and uses progressively finer grits of sandpaper to put a mirror sheen on the axles, helping to reduce friction. Dad also uses dry graphite lubricant in the wheel hubs when applying the wheels to the cars.
For this year's car, my son wanted to create Galvatron, from the Transformers universe. Galvatron joined Optimus Prime (last year) and Bumblebee (three years ago ... there was no Pinewood Derby in 2021 in our area, due to the pandemic) in his collection of Pinewood Derby cars. My daughter wanted a "sparkly, shiny" car. This year's car joins her collection of previous Pinewood Derby cars, which include the purple sparkly car from last year, and Cruz Ramirez (of the movie Cars 3) from 2020. It's easy to see a recurring theme here in their choice of car designs.

My kids love competing in the annual Pinewood Derby. They are competitive, but not overly so. We (the parents) love them competing in the race. It teaches them sportsmanship, and that they get out of it what they put into it. So, the more work they put into it, the better they will do. They fully understand that aspect of it now, after participating in their third Pinewood Derby.
This year, my daughter tied for third place in the heats for her Cub Scout den. My son won "Cubmaster's Choice" for the design, styling and decoration of his car. They were very proud of their accomplishments, and mom and dad were too.
***************
This month's cover celebrates Valentine's Day. The image is from Pixabay, created by Jill Wellington.
***************
Until next month, I bid you peace, happiness, serenity, prosperity ... and continued good health!


PDF Part 3B: Manipulating PDF Files, Command Line Style
by Paul Arnote (parnote)
I began the series of articles about PDF files in the October 2022 issue. In that article, we talked about creating PDF files. Then, in the November 2022 issue, we talked about editing PDF files. In the January 2023 issue, we talked about how to use various GUI tools to manipulate PDF files.
This article represents what I plan to be the last article in the series. In this one, we'll look at using some of the many command line tools available for manipulating PDF files. While I know that there are many users who avoid the command line like the proverbial plague, these command line tools are exceptionally easy to use. They are definitely the fastest way to manipulate PDF files, too. These tools follow the do-one-job-and-do-it-well philosophy that is so common for so many Linux utilities.
Let's Install The Tools
Your installation of PCLinuxOS does not come with all of these PDF tools already installed. Because of my involvement with The PCLinuxOS Magazine for all of these years, these tools have become "good friends" who have earned their rightful place in my PDF tool chest. But, you don't have to have intimate involvement with this magazine to find everyday uses for these tools, as you'll see in the examples that accompany the description of some of these tools.

Many of the PDF tools available on one of my computers.
The above image shows many of the command line PDF tools available on one of my computers. Users won't have to install each and every one of them, one by one. Instead, installation of pdftk and pdfjam will install most of these tools. Both of those packages are available in the PCLinuxOS repository, and installable via Synaptic.
I will issue one caution, though. The pdfjam package lists TexLive as one of its dependencies, and the TexLive package is quite large. You might want to check to ensure you have adequate space in your root partition. Uninstalling programs you never use can help a lot, but be cognizant of what each program you want to remove will take with it. You might want to avoid uninstalling programs that want to remove other seemingly unrelated programs/packages. For example, on my "travel" laptop (where these tools are also installed), I had to get rid of things I never use, like Thunderbird and Bluetooth utilities (that particular laptop doesn't have Bluetooth capabilities, so they were completely unnecessary on that computer), or I'd have not had sufficient space to install the TexLive packages.
If you have links in your PDF file, they may or may not be preserved in the manipulated PDF file. It would be a good idea to check to see if your links are preserved before sending out your manipulated PDF file. I can tell you right now that any files manipulated by pdfjam will NOT have their links preserved. The author admits this up front, on his GitHub page.
I will not be covering all of these tools. Instead, I'm going to cover the tools that I perceive to have the broadest appeal to general users. Some of these tools are specific to either TexLive or LaTeX, and I have neither the interest in, need for, or knowledge of those particular publishing packages. Having previously looked at them, I came to the conclusion at that time that they are probably overkill for my needs. Your needs, however, may differ. If so, you will most likely have a better idea of how to use those particular LaTeX/TexLive tools than I do.
So, let's take a look at some real world uses for some of these commands that allow us to manipulate PDF files. Some of them may seem whimsical, but most of them are quite useful. It would be a trivial task to "automate" the use of some of these commands in a bash script, even going as far as adding Zenity dialogs. But we'll focus on just using them from the command line.
Let's Join Multiple PDFs Into One: pdfjoin & pdfunite
This is one that I use fairly regularly. My kids school publishes the school cafeteria menus online in some funky online viewer that only allows you to view either the breakfast, lunch or the menus, one at a time. It's much easier to create a PDF file of each menu, and then combine them into one unified PDF. My kids aren't super picky eaters, but there are some NASTY food choices periodically. On those days, they prefer to take their lunch to school, instead of eating the nasty menu item d'jour. As such, we help them track the menu items to make sure they have something they like. Otherwise, they will go hungry and their education may suffer. After all, it's hard to learn on an empty, growling, hungry stomach.
To do this, I open the funky online viewer and choose to print the menus. As the output, I choose "Save to PDF..." as my printer from Firefox's printer selection dialog box. I then give each menu a unique name. For example, when downloading January's cafeteria menus, I named them Jan2023Breakfast.pdf, Jan2023Lunch.pdf, and Jan2023Snack.pdf.
Then, I cd to the directory where I stored them, and enter the pdfjoin command as such (all on one line):
pdfjoin Jan2023Breakfast.pdf Jan2023Lunch.pdf Jan2023Snack.pdf -o Jan2023-Menu.pdf
Here is the output of the entire operation:

Just list the PDF files in the order you want them to appear in the new, unified PDF file. That new PDF file is designated by the -o command line switch, with the name of the new PDF file specified as its parameter. In my example above, it's called Jan2023-Menu.pdf. I then copy that new PDF to my desktop, where I can pull it up quickly as the kids are getting ready for school. And, it's all there, all together, in one easy to read PDF file.
Now, I could just enter the full path to each file, instead of issuing the cd command to change to the directory where I saved the files. I choose to use the cd command to move to the directory where I saved the files, because providing the full path for each file gets unwieldy and introduces too many chances for errors.
The pdfunite command line tool is offered up by the Poppler developers, and works pretty much the same as pdfjoin. There are some subtle differences. For example, you don't need to preface the output file with the "-o" parameter. Instead, you just list the PDF files you want to "unite" into one PDF file, and list the output PDF filename as the very last parameter. There are no other command line switches, aside from -v to display the version of pdfunite, or --help to display the help contents for the tool.
I also approach the use of pdfunite the exact same way as I do with pdfjoin (which is made by the author of pdfjam), using the cd command to move to the directory holding the files I want to "unite" into one PDF file, and run the command from that directory. Just as with pdfjoin, you can use fully qualified path and filenames, but it's much easier to just have everything in that one directory, and join them all together from within that directory.
Let's Put A Spin On Things: Rotating PDF Pages
So let's look at another situation. We keep copies of all of my son's IEP (Individualized Education Plan), his quarterly IEP updates, his progress reports (grade cards), the results of district-wide testing ... basically, anything that helps us track his academic progress are things we keep digital copies of. And yes, we do the same for my daughter. She doesn't have an IEP, but we keep records of all of the rest of her documents to be able to track her academic progress, as well.
The local school district has been informed of our independent record keeping at home, and have agreed to forward these documents to us, via email, as a PDF file. Despite their agreement to do so, they do not always follow through. Thus, when they bring home paper copies of these documents, I have two choices. First, I can contact their current teacher, and have them send a digital copy of the document. My other (second) choice is to digitize it myself.
While I **do** have a flatbed scanner, it's much easier to scan the paper copies of the documents sent home with the kids using Adobe Scan on my smartphone (available on the Google Play store for Android, in the iOS App store for iOS devices, or you can view the Adobe product page for Adobe Scan here). It's faster and easier to do than to go to the computer connected to the scanner, fire that computer up, make the scans, yada, yada, yada. I then email the resulting PDF from my phone to my personal email. For all of my dislike of Adobe as a company, their Adobe Scan app works exceptionally well, producing the PDF files I need, far easier than even using a flatbed scanner. And, it's free.
HOWEVER -- and this is where the next command line PDF tools come into play -- sometimes the PDF files appear in the wrong rotation. Now, I could just rescan the documents, but that is frustrating. Rescanning the documents also takes longer than just using the command line tools to "fix" the improper rotation or page orientation.

Text orientation from original scan
While I could just print the document scan out on my printer and just rotate the paper after it's printed, it's a bit difficult to read as a PDF file in its current state. So, we need to rotate the text. The pdfjam utility includes three special tools that allow rotation of the text. They are called pdf90, pdf180, and pdf270. The numbers at the end of each command indicate the number of degrees the text is rotated, going counterclockwise. So, if you think of the rotation as the position of the hour hand on a clock, then pdf90 is at the nine o'clock position, pdf180 is at the six o'clock position, and pdf270 is at the three o'clock position.
Since the document is presented 180 degrees out of its intended rotation, we'll use the pdf180 command to "fix" the document. Below is the command execution and output from the pdf180 command:

I've highlighted the actual command (entered all on one line) used to accomplish the rotation of the PDF file in the terminal output above in red text. Notice that there is no need to specify an output file. That is because the original filename is preserved, with "-rotated180" appended to the end. This allows you to perform the rotation without fear of overwriting the original.

Tada! Now, the text is rotated for proper reading in a PDF file. The conversion is fast (faster than rescanning) and easy (easier than firing up a separate computer that has a scanner attached).
Let's Gain More Info/Knowledge: pdfinfo

Believe it or not, the pdfinfo tool isn't a part of pdfjam or pdftk. Rather, it appears to be a component of the poppler PDF library files. That, however, doesn't diminish its value.
Unbeknownst to most users, there is a lot more information embedded in a PDF file than just what you can see in a PDF viewer. And, this tool won't actually manipulate PDF files, as it's geared towards revealing some of that information that is embedded in a PDF file that you never really get to see. The information it reveals is merely informational in nature.
Let's say you receive a PDF from ... somewhere/someone ... and you want to see what program the PDF creator used to create the PDF file. Simply run pdfinfo <filename> and you should be presented with output similar to what you see above. That information includes what program was used to create the PDF file, the page size, the size of the PDF in bytes, its creation and modification dates, and the PDF version employed. In the screenshot example above, you can see that the December 2022 issue of The PCLinuxOS Magazine was created with Scribus, along with all of the other information we listed.
Below are some other examples, displayed in screenshot snippets.

This PDF file was created by pdfTex, by using the pdfjoin command.
![]()
This PDF file was created by GPL Ghostscript, used by the CUPS-PDF print driver.

This PDF file was created by LibreOffice Writer.
![]()
This PDF file was created by Adobe Scan, on my smartphone.
Looking at the version numbers used (not shown here), most of the PDF files are created with either PDF version 1.4 or 1.5. I was a bit surprised to see that Adobe Scan used the older PDF version 1.3. I'm not sure why one of the later PDF versions wasn't used. I'll just chalk that up to the "things that make you go hmmmm" category. I'm sure there is a reason that I'm not privy to, and that Adobe isn't saying.
Let's Put It On The Web: pdftohtml
The pdftohtml tool is another that is supplied by the Poppler developers. Just as its namesake suggests, it converts the PDF file to a basic HTML file, suitable for displaying in a web browser. With minimal editing of the HTML file(s), you can make the HTML file look a lot like the original PDF. Personally, I wouldn't spend a lot of time trying to make it look exactly like the PDF. In my humble opinion, you're fighting a battle you can't win, and for one basic reason: you're dealing with different mediums. Unless you're just a glutton for punishment, it's unlikely that you will get them looking identical to one another. You might succeed every once in a while, but mostly you'll miss the mark.
In its simplest form, the command is exceptionally easy to use. Just use pdftohtml, followed by the filename of the PDF file you want to convert to HTML, e.g., pdftohtml <filename.pdf>. There are command line options available, but I'll leave you to explore those on your own, by typing pdftohtml --help at a command prompt. However, the simple form of the command will get the job done.
When you run the command, three HTML files will be created. One is for the index frame of the HTML, one is for the contents frame of the HTML, and the other one ties them all together. That last one will have the same name as the PDF file, and is the file you select to open the HTML file in your web browser. The index frame will have the same name as the PDF, but with "_ind" appended to the end of the base filename. The contents frame will have the same name as the PDF, but with "s" appended to the end of the base filename.
For relatively simple PDF documents, pdftohtml does an admirable job at creating a basic HTML file. It even does a decent (but not perfect) job of exporting images in the PDF to the HTML. But it does have limitations. The biggest limitation I found is that pdftohtml does NOT handle data in tables well ... as in, not at all in my experience. It will recognize the text in a table, but its output is not in a table format. Rather, all of the text is "dumped" into the HTML, and it's very difficult to discern what data belongs with any of the other data.
Let's Extract The PDF Text: pdftotext
Similar to pdftohtml, the pdftotext tool extracts the text data from a PDF to a plain ASCII text file. You can specify the text file filename as an option, but if you don't, the text file will be given the same name as the PDF.
In its simplest form, the command goes like this:
pdftotext <PDF-filename.pdf> <optional-text-file-filename>
So, using my "From The Chief Editor's Desk..." article from the November 2022 issue, I issued the command like this:
pdftotext Nov2022-Welcome.pdf
The text of that PDF was output to a plain ASCII text file, and given the same name as the input PDF.
There are command line options available (such as the first and last pages to extract text from), but they aren't required. Without specifying the first and last pages of text to extract, all of the text from the PDF will be extracted to a plain ASCII text file. I'll leave you to explore the various other command line options. To see a list of them, type pdftotext --help at the command line prompt.
Let's Extract Those Images: pdfimages
There may be times when you need access to an image file, but the only copy of an image you have access to is in a PDF file. You could do a screenshot of the image as it appears in a PDF file, but there is another way.
The pdfimages tool, courtesy of the Poppler developers, will extract the images from a PDF file. And although it's rather picky about its command line parameters (particularly the path statements), once you get the hang of it, it's quite easy to extract those images.
In the example below, I used the PDF of my November 2022 "From The Chief Editor's Desk..." article. I created a special subdirectory to extract the images to, called TestImages. Then, I used the cd command to change the working directory to where the PDF file is stored. Finally, I executed the command as follows:
pdfimages -png Nov2022-Welcome.pdf ./TestImages/Image
So, the -png parameter tells pdfimages to save the images as PNG files. If you want to save the images as JPG files, use -j in place of -png. You can also save images as TIFF files, just by replacing -png with -tiff. If you omit the -j, -png, or -tiff command line switch, monochrome images will be saved as PBM files, and color images will be saved as PPM files. Those are fine, even if they aren't necessarily the most common graphic format on the planet. I prefer to work with either PNG or JPG files.
Similarly, if you use the -all command line switch, pdfimages will save the images from the PDF in every graphic format it is capable of saving them in. If you just want a list of images available, use the -list parameter, and you can omit the base filename for the images, e.g. pdfimages -list <;pdf-filename>.
Next, we specify the PDF file we want to extract images from. Finally, we provide the path and base filename for the images. In the example above, the images will be saved in the TestImages subdirectory, with the base filename of "Image". If you omit the path part of the statement (and just specify a base filename, which is required to extract the images), the images will be saved to the same directory as the PDF file. I prefer to use the subdirectory, just to keep things neat and tidy.
Let's Make An Image Of Each Page Of A PDF: pdftoppm
If you want to make an image copy of a PDF (or pages of a PDF), you can use the pdftoppm tool, also provided courtesy of the Poppler developers. While pdfimages allows you to extract images from the PDF, pdftoppm allows you to make image copies of entire pages in a PDF.

The format for the pdftoppm command is similar to that used by pdfimages. Here's an example:
pdftoppm -jpeg Nov2022-Welcome.pdf Image
Just as we've done with other commands, first use the cd command to switch to the directory that holds the PDF you want to make images of. The -jpeg command switch tells pdftoppm to create JPG files. The -png switch makes PNG files, and the -tiff switch makes TIFF image files. Without any switch, pdftoppm will create PPM graphic files.
The "Image" parameter forms the base filename of the images created by pdftoppm. Like with many of the other PDF command line tools, you can optionally specify a range of pages to make images of. Type pdftoppm --help at the command prompt to see all of the optional command line options.
Let's Embed & Extract Files From The PDF: pdfattach & pdfdetach
Now here is something I didn't know you could do with PDF files. Ok ... that's not entirely true. I knew the capability existed, but I never explored how to use or leverage the capability, until now.
Did you know that you can embed files into a PDF file, and then later extract those files? It's actually WAY easier than you might have thought. When I figured it out, I was like "What!? That's all there is to it?"
The possible uses for this are endless. I can't tell you how many times I've shared a custom bash script in the magazine, only to direct users to download a copy of the script from the magazine website. Several times I had wished that there was a way to deliver that bash script to the end user with the PDF. It appears that capability has been available all along.
You can embed plain, easily readable files into the PDF, or they can be encrypted files (i.e., a password protected tar.gz or zip file). If it's the latter, just be sure your intended recipient knows how to decrypt those files. The obvious advantage to using encrypted files is that should someone stumble across your files embedded into a PDF, they won't be able to access that data unless they know how to decrypt those files. I know this all sounds a bit clandestine, but it is one possible scenario that could be played out.
Conversely, embedding unencrypted, easily readable files carries the promise of sharing your files with as many people as possible. You can easily embed encrypted and unencrypted files into the same PDF to allow extraction of all of the files, but only some of the files will be accessible by all, and the rest of the files will only be accessible by those who possess the decryption key.
So, with all of that out of the way, let's take a look at how simple it is to attach files to a PDF, and how simple it is to detach files from a PDF. Obviously, we need to attach files to a PDF first, so we can have something to detach. These commands come courtesy of the Poppler developers.
To attach files to a PDF, you will need to use the pdfattach command. The format for the command couldn't possibly be easier.
pdfattach <name-of-original-PDF> <name-of-file-to-attach> <name-of-output-PDF>
As far as I can tell in my trials, you can attach one file at a time to any given PDF file. So, if you have multiple files to attach, just do them one at a time, incrementally. Don't worry, because it's really fast and easy. I find it's easiest to cd to the directory that contains all of the files (the PDF and any attachments), and perform the feat there. You could use fully qualified path names for all of the files, but you also introduce a greater chance for errors. Putting all the files in one directory makes this so much easier. I give each iteration of the command a unique output filename, as well. That way, **just in case** something gets messed up, you don't have to redo everything. Plus, it's never a good idea to overwrite your original file. You can always rename it later, if you choose.
Surprisingly, attaching files to a PDF comes with quite a small overhead. To estimate the final file size, add the number of bytes in the PDF file to the number of bytes in the file you're attaching, plus approximately 800 more bytes. The 800 bytes is probably due to internal pointers within the new PDF file that point to the extra attached file(s). When you stop and think about it, 800 bytes really isn't too much overhead at all.
Now that we have our file attached to the PDF, we need a way to detach them. This is where the pdfdetach command comes into play. While there are other options (type pdfdetach --help at a command prompt to view all of the options, or search for pdfdetach man page on the web), there is one really good way to detach them with maximum ease.
pdfdetach -saveall <name-of-PDF-file-with-attachments>
When run this way, all of the attached files will be detached from the PDF, and written to the same directory as the PDF file. If you want to be a little neater about it, you can specify a path for the attached file(s). Here's an example using a relative path:
pdfdetach -o ./Files -saveall <name-of-PDF-file-with-attachments>
Be forewarned that this directory MUST already exist, because pdfdetach will NOT create the directory for you. If you try to detach a file (or files) to a directory that doesn't already exist, the command will end with an error, and none of your files will be detached. If successful, all of your files will be written to your drive, complete with their original filenames.
Let's Output Multiple Pages On A Single Sheet: pdfxup
Sometimes, it's advantageous to be able to output multiple pages of a PDF on a single sheet. I know I've been to seminars where the speaker will hand out "miniaturized" printouts of their presentation, often with three, four, or even six of their "slides" on a single page. It allows you to follow along, and gives you an opportunity to take notes throughout the presentation.
There are "other" programs that accomplish the output of multiple pages on a single page (namely, pdfjam-slides3up and pdfjam-slides6up), but pdfxup gives you the greatest flexibility, and is still very easy to use. Keep in mind that the use of ANY of these three programs will strip out all links that might be in your original PDF file, so don't count on them working after the conversion.
By default, pdfxup creates the multi-page layout in a portrait page orientation. Here's the command and its output:

I've used the January 2023 issue of The PCLinuxOS Magazine for my example here. As I've done throughout this article, I use the cd command to move to the directory where the PDF file resides to run the command. You could use a fully qualified path statement, but that can get awkward and unwieldy, and is more prone to typing errors. The -nup 2x3 parameter tells pdfxup to make the new PDF two columns wide and three rows deep for each page. The -o parameter is the filename for the output of the new PDF file. Give it a new, unique filename, to avoid overwriting your original file. In our case here, I've appended "-6up" to the original filename. The third parameter is the original PDF file to use to create the new multi-page PDF file.
And here is the result it produces, as seen in a PDF file viewer:

If you want to produce a document in the landscape page orientation, we'll have to slightly alter the command. Here's that command and the output, using the same input file of the January 2023 issue of The PCLinuxOS Magazine:

First, change the -nup parameter from 2x3 to 3x2. This will produce three columns on the page, two rows deep. Also, add in the -l (that's a small case "L") parameter, which tells pdfxup to produce the new pages in the landscape page orientation.
Here is the result of that command:

Believe it or not, the pages of the multi-page layout are actually readable. On my PDF viewer, I can zoom in to 500% and read them comfortably. Not only that, but they look as good as the full-size pages.
Don't go for the multi-page layout option because you think it will result in a smaller PDF file. Nothing could be farther from the truth. The resulting files will be quite big. The January 2023 issue of The PCLinuxOS Magazine that was used for this demo is only 7.1MiB in file size. Both of the multi-page PDF layouts are about 6X the size of the original PDF, coming in at 43.3MiB in file size ... each.
There's nothing restricting you to a 2x3 or 3x2 layout, either. If you only want two page views per page, then make your layout 1x2 or 2x1, depending on whether you're using portrait or landscape page orientation. Or, you could use 3x3, 4x3 or 3x4 ... whatever arrangement you want.
Let's Search Through PDF Files: pdfgrep
If you read enough PDF files (and I hope you are, at least with The PCLinuxOS Magazine), there's going to come a time when you will remember reading something, but have trouble finding exactly which PDF file the information it is in.
The pdfgrep command can help you find what you're looking for. Here's an example of using the command:
pdfgrep -i pclinuxos 2023-01.pdf
As usual, use the cd command to go to the directory containing the PDF files you want to search through. The -i parameter tells pdfgrep to ignore the case of the search term. Our search term is "pclinuxos" in this example. Thus, pdfgrep will report a "hit" on all occurrences of "pclinuxos" regardless of the case of the letters. Finally, we searched through the January 2023 issue of The PCLinuxOS Magazine.
You could just as easily use a wildcard when specifying the file you want to search. So, if you have a directory full of PDF files, you could replace the "2023-01.pdf" filename with "*.pdf" to search all of the PDF files in that current directory. You could also redirect the output from pdfgrep to a text file, if you receive too many "hits" on your search term. That might help make it easier to find what you're looking for. Most of us can't read as fast as the data streams across our screen in a terminal session.
There are other command line switches you could employ. You can view them by typing pdfgrep ---help at the command prompt. For an even more detailed list of options, try typing man pdfgrep at the command prompt. I'll leave it up to you to explore those other options. As presented here, pdfgrep provides a really decent way to search through your collection of PDF files to find the information you are looking for.
Let's Get Whimsical: pdfflip
I honestly have NO IDEA why anyone would want to do this, other than the fact that it's a bit fun to see the results. Imagine you're standing behind a semi-transparent projection screen, and you're looking at a document being projected upon that screen. That view is what you get with pdfflip.
Here's the command:
pdfflip --suffix 'flip'
pdfflip --suffix 'flip' Nov2022-Welcome.pdf
And here is the result of that command:

Like I said earlier, I have NO IDEA why anyone would ever want to do this, other than to view the results and/or to say that you can. Keep in mind that, as with all pdfjam tools, any links you have will not make the transition to the new flipped PDF file. The pdfflip tool also does not work on encrypted PDF files.
Summary
As you can see, there are a LOT of tools available for manipulating PDF files from the command line. And, they're not at all difficult to use. There's also no argument that they perform their jobs fast.
There are more tools that we didn't cover, but I consider those to be "special use" tools or duplicates of the ones we've already covered. For most users, the commands presented here will be more than adequate to cover their PDF file manipulation needs.



PCLinuxOS Recipe Corner: Sauerbraten Meatballs
Sauerbraten Meatballs

Serves: 2
INGREDIENTS:
Meatballs
1/2 lb extra-lean (at least 90%) ground beef
2 tablespoons finely crushed gingersnap cookies
2 tablespoons red wine vinegar
1/8 teaspoon salt
1/8 teaspoon pepper
1 small onion, finely chopped (1/4 cup)
1 egg white
Noodles
2 1/2 cups uncooked egg noodles (4 oz)
Sauerbraten Sauce
1/4 cup finely crushed gingersnap cookies
2 tablespoons raisins
1 tablespoon packed brown sugar
3/4 cup reduced-sodium beef broth
1 tablespoon red wine vinegar
DIRECTIONS:
Heat oven to 400F. In a small bowl, mix all meatball ingredients. Shape mixture into 10 (1 1/2-inch) meatballs. Place in an ungreased 13x9-inch pan. Bake for 20 to 25 minutes or until thoroughly cooked and no longer pink in center; drain.
Meanwhile, cook and drain noodles as directed on the package, omitting salt.
In a 2-quart saucepan, heat all sauce ingredients to boiling, stirring occasionally; reduce heat to medium. Cook for 5 minutes, stirring occasionally, until thickened.
Stir the drained meatballs into the sauce. Serve over noodles.
TIPS:
Instead of noodles, try serving the meatballs with brown rice or whole wheat couscous.
NUTRITION:
Calories: 540 Carbs: 71g Fiber: 3g Sodium: 440mg Protein: 33g

Inkscape Tutorial: Design A Mandala
by Meemaw
I go on YouTube regularly to try to learn more about GIMP & Inkscape. Recently, I found another channel called IronEcho Design, and he had a couple of videos about creating a mandala. Mandalas are symmetrical geometric designs and are getting a bit more popular. They can be simple lines, or more complicated. I got these first two from Pixabay.

Rick from IronEcho Design has at least two tutorials on mandalas, so I thought I'd share the process with you. The first step is always to open Inkscape.
In this project it will be good to activate Snapping. I usually deactivate it so I can move things wherever I want them, but it needs to be turned on for now. Also, instead of making this huge, choose Letter or A4 size. Remember that since this is saved as an .svg, you can export it in a bigger size when you're finished. The next thing you should do is create 2 guides, one horizontal and one vertical, in the exact center of your page. The easiest way is to click Extensions > Render > Guides Creator.

In the window that appears, choose 2 rows and 2 columns, and the guides will be in the center of your page.

Now we're ready. Using the Bezier tool, draw 3 or 4 lines touching the top half of the vertical guide. Let each one snap to the guide. Don't worry about their shape yet. Select them all, then group them. Also, click Path > Object to path. Now we can use the Path Effects to help our work along. Click Path > Path Effects, and the path effects dialog will open.

Pretty empty, huh? Well, there aren't any effects unless we add them. The first one you need to add is Mirror symmetry. With your lines chosen, you'll see that the effect has mirrored your lines.

Now add Rotate Copies. When you first see it, it looks really weird, but that's fixable. Change to the Edit paths by nodes tool. A small square will appear in the center of that jumble.

Grab that square (handle) and move it down to the spot where your two guides intersect. While you're doing that your lines wil (magically) move around the guides, now making a symmetrical drawing.

What's really cool now is that if you edit one of the lines you originally drew (curving it or moving it) the same edit will affect all the copies of the line around the drawing. I'm going to edit a bit.

There's a lot I can do to this, but first, I'm going to group everything and rotate it just a bit. That way, I can do the same thing again and fill in between the outer figures. OH... if you add any small items, like circles or spirals, add them the same way (next to the guide) and use the same path effects. The circles and lines were added before I rotated my drawing.

Just keep using the two path effects that you've been using, save frequently, and keep going to get what you want. Rick from IronEcho said to save the parts you do separately, because the more you group and try to work with, the more it taxes your CPU. You can group and save all when you're finished creating... or just save and export. I'm sure I could do more, but I decided to stop here:

The other good thing about this is that you can design it however you want, so every design is unique. You can also fill it with colors. I'm sure yours will be wonderful!


Repo Review: Koodo Reader
by CgBoy
Koodo Reader is a modern and feature-rich ebook reader powered by Electron. It offers support for Epub, Mobipocket, Kindle, PDF, HTML, and numerous other common ebook and document formats. It is also ideal for use in study work, as you can easily highlight and annotate text in any document.
Sporting a modern and well designed user interface, Koodo Reader is quick and easy to use. It also has optional support for touchscreen gestures and usage. A dark interface mode can be enabled for reading books at night as well.

Loading books into Koodo Reader is accomplished by clicking Import and selecting an ebook file located on your computer, or by dragging and dropping compatible files into the program. Added books will show up in the main Books screen, where they can be sorted by book name, author name, most recently read, reading duration, and so on.
Koodo Reader lets you organize your books into different bookshelf categories, which can be selected from the Shelf menu near the top of the screen. You can also favorite any books you have loaded in, allowing you to easily find them from the Favorite tab on the left. From the Notes and Highlights tabs, you can quickly view and jump to any sections of text you've highlighted or attached notes to in any of your books.

Clicking on a book opens it up in a nicely designed reading window. Selecting a section of text brings up a small box allowing you to highlight and annotate the text, search in the book or online, and also translate and speak the text. Neither the translation nor the text-to-speech functionality seemed to work when I tried them, though.
Moving the mouse cursor towards each side of the window brings up different panels. At the lower edge of the window is a panel that shows your progress through the book and allows you to navigate to a specific page, while a panel at the top of the window lets you exit the book, bookmark a page, or switch to fullscreen mode, while also displaying the estimated reading time left. From the panel available on the left side, you can view the book contents, bookmarks, notes, and highlighted text in the book. On the right side panel, you'll find a large amount of reading options available, such as page style, background and text color, font and text spacing settings, along with various other options.

Koodo Reader provides you with the option of backing up your library, either to a local directory as a zip archive, or to an online cloud storage provider, such as Dropbox, or WebDav (Google Drive support is supposed to be added soon). Koodo Reader also supports synchronizing your data across multiple locations, but I was not entirely sure how to actually configure and use this feature.
Summary
I found that Koodo Reader generally seemed to work very well as an ebook reader. Some features, though, look as if they aren't fully implemented yet, such as the text-to-speech ability. All in all, Koodo Reader is a very impressive application, and one of the most advanced ebook readers available in the PCLinuxOS Repository.

Good Words, Good Deeds, Good News
compiled by Meemaw
German Shepherd Protects Six-Year-Old

Tank the German Shepherd and his 6-year-old human were outside playing, when a dog across the street charged over and tried to attack the boy. Tank immediately pushed the boy down and got between him and the other dog.
The other dog in the child's home, a pit bull, helped Tank chase the attacking dog away. The home security camera had filmed it, and it shows the child's mother coming out and hugging her son. She has also uploaded it to TikTok, and it has been viewed over 45 million times.
Her caption reads, "THE MAN, THE MYTH, THE LEGEND This is Tank & no, he is not professionally trained. He's just a man with killer instincts, who loves a good chew toy."
Officer Reunites With Man She Rescued

Back in 1998, Officer Anne got a call about a child wandering outside in and out of traffic. When she arrived at the scene, she got the boy out of traffic and placed him in her patrol car. She took him to her car, and on to the police department where he could be comforted and taken to foster care, where he was later adopted.
That's all that Roberto Theiss can remember, but in November, 2022, he returned to the same department to thank Anne for her kindness, saying that she saved his life
From the South Bend report, "Theiss said he wanted to 'let her know again how that little action she did changed my entire life and I cannot express words of gratitude.'"
Ohio Couple Delivers FedEx Packages

Tristan and Zachary were driving home one night when they saw a FedEx truck at the side of the road. When they slowed down to pass it, they saw an unbelievable sight! The driver appeared to be throwing packages into the ditch. By the time they got turned around and went back, the driver had left, but there were multiple packages in the ditch.
Zachary said, "I mean there was flowers, somebody's flowers, like that broke my heart, because it could've been for anything, funeral flowers."
They proceeded to pick up all the packages and deliver them, taking over two hours to do so. They said they didn't want to call the police because they were afraid that the packages would just sit in a police station and not get to the intended recipients. They do want the driver to be caught and held responsible, though.
Missing K-9 Reunited With His Handler

Gunner the bloodhound was at a training exercise in South Carolina when he "jerked away" and ran into a wooded area. Officers started searching for him, and after 25 hours of searching, they found him. He was cold, wet and thirsty, but in good health.
Terminally Ill Boy Receives Message From Captain Jack Sparrow

Kori is 11 years old, and has already gotten two heart transplants. In spite of that, he is an avid YouTuber and hopes to someday reach 100,000 subscribers on his channel, Kraken The Box, which would earn him a Silver Play Button Award.
In December, he shared a video of Johnny Depp speaking to him, dressed as his favorite character.
From the news story, Depp said, "Captain Kori, I understand you're quite the YouYube channel man. So what I'm saying is I would be glad to follow your YouTube channel and will tell all my friends to follow your YouTube channel," said Depp, who was portraying Captain Jack Sparrow from Pirates of the Caribbean.
"I wish you the best of luck, I'm your number one fan Captain Kori, all my respect and love," Depp added.
A couple of days later, an elated Kori shared another video of him and the well-known actor having a conversation through a video call. Depp continued to portray Sparrow while pretending as if he were on a pirate ship.
Users posted of their happiness for Kori, and praised Johnny Depp for his kindness.
Student Given Sports Wheelchair

Sixth grade student Angel goes to middle school in Arkansas, and although he's in a wheelchair, he joins his friends who are on the cross-country team. This last Christmas, an anonymous donor presented him with an athletic wheelchair in an assembly at his school.
The athletic wheelchair is lighter than a standard wheelchair and generally built with the large side wheels tilted for easier control. Angel's new chair is "better-suited to the terrain."
![]()

Short Topix: Major Layoffs Announced Across Tech Industry
by Paul Arnote (parnote)
Monthly Update: Assault On Your Privacy

Last month it was LastPass, and the dust has hardly even started to settle from that data breach. Now, it's someone else's turn. Thousands of Norton LifeLock customers had their accounts compromised in recent weeks, potentially allowing criminal hackers access to customer password managers, the company revealed in a recent data breach notice, according to an article on TechCrunch. The information was also relayed on Slashdot.
A new high-severity vulnerability has been discovered that affects Google Chrome and other Chromium-based browsers like Microsoft Edge, according to an article on Tom's Guide. The vulnerability, dubbed SymStealer and tracked as CVE-2022-3656 (opens in new tab), was first discovered by security researchers at Imperva and more than 2.5 billion users could be at risk of potential attacks if they aren't running the latest version of Chrome. If exploited, an attacker could use this vulnerability to steal sensitive files from a users' computer including banking and crypto wallet credentials that could then be used to drain their accounts.
An unusual phishing technique has been observed in the wild, hiding empty SVG files inside HTML attachments pretending to be DocuSign documents, according to an article on BleepingComputer. Security researchers at email security provider Avanan named it "Blank Image." They explain that the attack allows phishing actors to evade detection of redirect URLs.
The entirety of the US "No Fly List" has been exposed online by a Swiss hacker who reportedly found three sensitive files stored on an unsecure cloud storage server, according to an article on TechRadar. One of the files contains the information of more than 1.5 million entries into the list, which covers individuals who have been barred from traveling to or from the US. The data was found out of boredom, according to a blog post written by the hacker, known online as maia arson crimew, which saw her searching Shodan for exposed Jenkins servers.
From the "it bears to be repeated again and again and again and again" department, the Tom's Guide website lists some strategies to protect yourself from some of the most common phishing attack vectors.
Criminals took advantage of an improperly configured API to steal the personal data of 37 million T-Mobile customers, such as customer names, billing addresses, email addresses, phone numbers, dates of birth, and T-Mobile account numbers, according to an article on TechRepublic.
Meta has once again been hit with a major GDPR violation, earning itself more than $400 million in fines for its latest data privacy misstep. The EU's Ireland-based Data Protection Commission levied two sets of Data Protection Commission levied two sets of fines after ruling that EU-based users have been illegally forced to accept personalized, targeted ads from both Facebook and Instagram, according to an article on TechRepublic. Naturally, this isn't the first rodeo for Meta facing fines for violation of the GDPR.
Bitwarden and other password managers are being targeted in Google ads phishing campaigns to steal users' password vault credentials, according to an article on Bleeping Computer. User beware. It's vitally important to inspect links before you click on them to make sure they aren't a spoofed version just looking to grab as much of your data as they can.
Once In A Lifetime Visitor

The last set of "human eyes" to have ever viewed this celestial visitor were probably Neanderthals. Comet C/2022 E3 (ZTF), a.k.a. the Green Comet (kind of sounds like one of forum member Arjaybe's novels, eh?), is making a near-Earth visit. On or around February 2, it will be making its nearest approach to Earth at only 28,000,000 miles (approximately 45,000,000 Km) away. The Green Comet takes 50,000 years to make its journey from the Oort Cloud to the sun, and then back out to the Oort Cloud.
The once-in-a-lifetime visitor will increase its visual magnitude to around +5.5, which means that it will be visible to the naked eye (depending on conditions) or with binoculars as it swings by Earth on its eons-long journey. A bright, waxing gibbous Moon may hinder visibility with the naked eye, though, in early February.
The comet will be visible (in the Northern hemisphere, anyway) slightly below Ursa Major, a.k.a. the Big Dipper, and may appear as a faint green smudge in the sky to the naked eye. Binoculars and telescopes will help garner a better view of the celestial visitor, as will getting far from the light pollution that will inhibit viewing in more urban areas.
Information about the comet's visit to the inner solar system is widely available on the internet. The comet's arrival has been widely covered in many media outlets. Here's a DuckDuckGo search for your convenience. If you're wanting to find more specific information, Wikipedia has a nice entry on the comet. Celestron (yes, the makers of the famous line of telescopes) has a nice entry about it on their blog. The Planetary Society also has a very nice and informative report on the comet.
Major Layoffs Announced Across Tech Industry

2022 and 2023 (so far) have NOT been kind to tech industry workers. First the pandemic forced many in this sector to work from home. With the pandemic "lockdowns" that swept the globe, much of the tech industry saw an uptick in relevance and usage. Now, greed the pursuit of ever-increasing profits has led to many companies in the tech industry to start to cut staff.
Over the past two years, tech industry workers have faced massive layoffs. How massive? Well, according to a CNBC article, over 70,000 have been axed. In November 2022, Meta cut 13% of its workforce, which amounts to over 11,000 of its workers. Alphabet, the company behind Google, announced a layoff of 12,000 of its workers. Microsoft announced a layoff of 10,000 of its workers. Amazon laid off more than 18,000 of its workers. Crypto.com has laid off around 500 of its workers. Coinbase cut 2,000 jobs. Salesforce has cut 10%, or 7,000, of its employees. Elon Musk's Twitter let 3,700 of its employees go after he purchased Twitter. Lyft cut 13% of its employees, or about 700 jobs. Stripe cut 1,100 jobs from its ranks. Shopify sent 1,000 employees packing. Netflix cut 450 employees from its payroll. Snap cut 1,000 jobs. Robinhood cut 1,100 jobs. Tesla axed 6,000 workers.
Let's add that up ... 11,000 + 12,000 + 10,000 + 18,000 + 500 + 2,000 + 7,000 + 3,700 + 700 + 1,100 + 1,000 + 450 + 1,000 + 1,100 + 6,000 equals 75,550 jobs.
Meanwhile, revenues for these companies, for the most part, hit record levels in 2021 (the last figures available for these companies). Alphabet posted revenues in excess of $250 billion. Microsoft delivered $168 billion in revenue. Meta posted nearly $118 billion in revenues. Amazon crushed them all, reporting annual revenues of nearly $470 billion. The list of growing profits/revenues goes on and on, up and down the list of the companies mentioned here.
For a really interesting take on the current round of layoffs that have besieged the tech industry, take a look at this article from The Verge website. It pretty much hits the nail squarely on the head.
PCLinuxOS Magazine Short Topix Roundup

Physicist Germain Tobar says that time travel may be possible, without the troubling paradox usually associated with it, according to an article on BGR. Of course, we would first have to figure out time travel before anyone can prove him right or wrong.
Most "best of" lists are highly subjective by their very nature. It's usually someone's opinion of what's "best" or "significant" that determines what "makes the list." What might be "best" or "significant" to one person may not be to another person. So, keeping that in mind, there are two lists of science's greatest achievements of 2022. One list, on the Visual Capitalist website, uses a graphical timeline of significant scientific advances of 2022. Another list of the "10 wildest scientific discoveries of 2022" is on the Listverse website.
There are many reasons to enjoy a cup of ruby red hibiscus tea, including its ability to warm the body in the winter, boost the immune system, regulate blood pressure, and aid in weight loss. Now, research has found that it could defeat Alzheimer's disease, according to an article on SciTechDaily.
Microsoft officially pulled the plug on the Extended Security Update program for Windows 7, effectively ending all support for the aging operating system, according to an article on Lifehacker. Initially released in October 2009, Windows 7 is STILL being used by roughly 11% of computers. This not only means no more updates ... period ... but that software vendors will also (most likely) stop supporting Windows 7 with their software releases and updates.
An article on the JStor website makes the argument for turning human waste matter into agricultural fertilizer. While that hasn't worked out well for North Korea (it's common knowledge that they use human waste to fertilize their agricultural fields), it's most likely because they aren't following the proven processes that turn human waste into usable fertilizer. One of the oldest plants is in Milwaukee, where they have been churning out Milorganite by the tons since 1925. Other plants exist scattered all around the world, using one of the three processes that have proven to be successful for turning human waste into fertilizer.
A TechRepublic article gives a breakdown on the next generation of wireless communications, known as 6G. Still in the R&D stages, it may be a little while before any of us see 6G networks roll out. Heck, many folks are just now getting access to 5G wireless networks.
An essay on the AEON website makes the case that there's no planet B. The scientific evidence is clear: the only celestial body that can support us is the one we evolved with.
Microsoft may be preparing to FINALLY replace the NTFS file system with a faster, better performing file system, known as ReFS, according to an article on the Windows Report website. Resilient File System (ReFS) is said to be more resilient, offers better performance than NTFS, and supports file systems up to 35PB (as opposed to NTFS, which only supports disks up to 256TB).
Can spicy foods cure colds? A neuroscientist reveals the encouraging truth in an article on Inverse. Spicy food does nothing against the rhinovirus, but it can ease symptoms.



![]()
Repo Review: SSVNC-Viewer
by Alessandro Ebersol (Agent Smith)

Today I will talk about the lightweight and versatile VNC client, SSVNC Viewer, which is in the PCLinuxOS repos.
SSVNC Viewer is the work of Karl Runge. Karl Runge worked on the LibVNCServer/LibVNCClient libraries and implemented a VNC server (the x11vnc) and the SSVNC-Viewer client.
The author, Karl Runge, however, disappeared around 2011, and there is currently no news about him.
The development of the LibVNCServer/LibVNCClient libraries is still active on github.
Runge's work has been incorporated into several programs that use the VNC protocol, such as:
And, the ssvnc-viewer client, has also been incorporated into several other programs, clients of the VNC protocol:
But, our focus is on the small and minimalistic ssvnc-viewer client.
How To Use It?
It's very easy. From a command line, or command execution box, type ssvnc-viewer.
Remember that this is a client for the VNC protocol. This means that there must be another computer running a VNC server to which ssvnc-viewer will connect.
After typing the command a dialog box opens.

In this dialog box you will be asked to enter the IP of the VNC server. If there is a password on the server, the dialog box will ask you to enter the password.
After the connection is made the remote screen will appear, as in the picture below:

After establishing the session with the remote machine, pressing F8 displays the ssvnc-viewer configuration screen:

And, all of its options can be configured, according to the user's needs.
As it is a minimalist program, there is not much to say about it, as it is simple to use, very fast and lightweight. There are many other VNC clients in the PCLinuxOS repos, but if you want a small, fast and simple client, ssvnc-viewer could be a solution.
I hope you enjoy it, and I also made a crash course on ssvnc-viewer on my YouTube channel.

Exploring LXQt: A Basic Guide, Part 1
by kalwisti (David Pardue)
Last year, I dabbled with LXQt on our old laptop (a secondary machine) but I had not taken an in-depth look at it until recently. I read the announcement about the release of LXQt version 1.2.0 -- on Nov. 5, 2022. Shortly thereafter, forum member daniel (Daniel Meiß-Wilhelm) created a Community LXQt 2022.11 .iso which incorporates the newest LXQt release. My curiosity was piqued, so I downloaded it, made a Live USB flash drive and installed the .iso on a spare partition of our Lenovo ThinkCentre M800 desktop computer. I would like to thank Daniel for sharing his remastering skills with the PCLinuxOS community.
My knowledge has expanded since I have been using LXQt almost exclusively for the past month. Thus far, I am impressed by LXQt; I find it comfortable enough that it could become my sole daily driver. It is a lightweight desktop environment that is useful for older PCs with limited resources. LXQt is visually appealing, feels responsive and strikes a balance between lightness and usability. Another advantage for "set-it-and-forget-it" users is that LXQt lacks the sometimes confusing multitude of configuration options in KDE Plasma.
If you are just starting with LXQt, I hope you will find these tips helpful and that they will save you some time as you explore the desktop environment.
Historical Background
Although LXDE coexists with LXQt and is technically still being maintained, it is living on borrowed time because it has a GTK2 codebase. LXDE's most recent stable release dates from 2016. LXDE's founder, Hong Jen Yee (aka "PCMan"), found it impractical to base LXDE on GTK3. GTK3 broke backward compatibility and caused components to slow down and become more memory-hungry. So Dr. Hong1 began experimenting with Qt as a base; eventually, his LXDE-Qt project merged with the Razor-qt project (in July 2013). LXQt is now the successor to LXDE. LXQt has developed into a mature project which will continue to improve over time. The DE's primary goals are simplicity and being light on resources, with sensible default settings that meet most users' needs. (In addition to his work in computer programming, Hong Jen Yee is a physician -- specializing in rheumatology -- at Taipei Veterans General Hospital, Taiwan. He temporarily stopped development of PCManFM in 2008, to focus exclusively on his medical studies.)
LXDE still exists but receives only infrequent updates. (I have read comments referring to it as "abandoned" or "quiet but not dead"). Lubuntu's last supported release using LXDE was 18.04 LTS which reached EOL in April 2021. The distribution switched to using LXQt exclusively with release 18.10 (in October 2018). Debian still offers a Live LXDE .iso and Fedora produces an LXDE Spin. Raspberry Pi OS uses a modified LXDE as its desktop environment. (Raspbian "PIXEL"[Pi Improved Xwindows Environment, Lightweight] was first released in 2016 and continues to be actively developed in a 32-bit version).
| Note: LXDE is no longer officially supported on PCLinuxOS. Texstar has recommended that users considering LXDE migrate to LXQt. |
However, if you are unfazed by LXDE's deprecated status on PCLinuxOS, a forum thread discusses installing Alie's Openbox remaster as a base, then installing the task-lxde metapackage via Synaptic. You can reference this thread:"[Solved]. Anyone Else Running LXDE on Top of LXQt?" PCLinuxOS Forums, 6 Dec. 2021.
If you need help, just be aware that a mere handful of forum members would be able to assist you. There is also an LXDE community edition from PCLinuxOS Brasil (with Portuguese-language localization), created by Agent Smith (Alessandro Ebersol).
List of Qt Desktop Applications
In theory, the lightest DE is usually one that shares resources with applications chosen from the same ecosystem. It is desirable to use Qt-based applications in an LXQt environment -- if possible. If you are running GTK-based programs in LXQt, you lose some of the lightness of a Qt5 desktop because you will be using extra resources to have both GTK3 libraries in RAM for your applications, and Qt5 for your desktop.
In practice, it can be difficult to follow this advice. Some of the programs I use regularly -- such as GIMP, GnuCash, HomeBank, Geany -- are based on GTK. In my experience, mixing applications from different "families" does not impact performance drastically, provided there is enough RAM.
The 2022.11 .iso resembles a PCLinuxOS Mini release, insofar as it does not include a large collection of applications by default. If you are new to LXQt, below are some suggestions for Qt-based desktop programs. (All of these are available in the PCLinuxOS repositories at the time I wrote this article).
Accessories
Office
Graphics
Web Browser
Internet
FTP
Text Editor
Multimedia
Education
Miscellaneous
If you would like a more detailed list, visit the Gentoo (Gentoo Linux Wiki. "Qt Desktop Applications." Last edited 30 Oct. 2022) and Manjaro ("List of Qt Applications: From Manjaro." Last edited 18 Dec. 2021) wikis.
Add Trash Can to Your Desktop
From the main menu, go to Preferences > LXQt Settings > Desktop. From the Desktop Preferences dialog window, click on the "Advanced" tab to bring it forward. Select (tick) the box next to "Trash".

Click the "Apply" button. Close the Desktop Preferences dialog window. A trash can icon should appear on your desktop:

Change Your Desktop Wallpaper
Right-click on an empty area of your desktop. A dialog window will appear. Select the "Desktop Preferences" option. Click on the "Background" tab to bring it forward. Locate the "Wallpaper image file" box. Click on the "Browse" button next to that field.

Using the PCManFM-Qt file manager, navigate to the directory: /usr/share/lxqt/wallpapers directory.

You will see some attractive (in my opinion) wallpapers to choose from. There are several wallpapers featuring Helix, the hummingbird mascot of LXQt.

As an alternative, you can of course choose your own personal wallpaper. In that case, navigate to /home/yourusername/Pictures. When you have chosen your desired wallpaper, click on the "Open" button. Then, click on the "Apply" button. Close the Desktop Preferences dialog window.
How to Add Quick Launchers
Method A
When you first start the LXQt desktop, you will notice the prominent "Drop application icons here" message on the top panel / taskbar. This allows you to drop-and-drag an application icon to create a Quick Launcher.

From the Main menu, select the program you wish to add a Quick Launcher for. Drag it up to the panel. The "Drop application icons here" message will disappear from the panel after you successfully add your first app's Quick Launcher.
Note: The panel is finicky about where it will allow you to drop the shortcut. It might require several attempts to add subsequent Quick Launchers. I had more success by dropping the shortcut on top of the File Manager's icon (PCManFM-Qt). However, once the Quick Launcher is there, I found it frustrating to move the Launcher exactly where I wanted it -- especially when there are multiple Launchers on the panel.
Once you have the Quick Launcher on the panel, Right-click on the icon and select "Move left" or "Move right" to position it to your liking:

Method B
Although this procedure involves more mouse clicks than Method A, I prefer it because it offers finer control over the placement of the Quick Launcher.
Right-click on the main menu. Choose "Manage Widgets":

The Configure Panel pop-up window appears. Click the green + [plus] button:

The Add Plugins pop-up window appears:

Scroll down and select the "Quick Launch" plugin. Click the "Add Widget" button

A new button labeled "Drop application icons here" will be added at the extreme right of the top panel.
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Right-click and choose the "Move Quick Launch" option.

Drag it to the desired area on the panel, or, Use the blue "Up" arrow to incrementally move it to your desired position:

Click on the Main menu, select your desired program, then drag-and-drop it on the newly created button.

A Quick Launcher (icon) will be added. In this example, it is the FeatherPad plain-text editor.

If you change your mind and would like to remove a Quick Launcher from the panel, right-click on its icon. Choose the option "Remove from quicklaunch".

How to Add Desktop Shortcut
I prefer having an uncluttered desktop, so I generally avoid using desktop shortcuts. However, if you would like to add them,follow these steps outlined here.
From the Main menu, select the program you wish to create a shortcut for. Right-click on it. Choose "Add to desktop".

Notice that there is a red exclamation mark superimposed on the new shortcut.

To eliminate the exclamation mark, right-click on the shortcut. Check (tick) "Trust this executable".

Now, the red exclamation mark will be removed.
Change the Display Manager from GDM to SDDM
Although the 2022.11 .iso ships with GDM (GNOME Display Manager) as the login manager, SDDM (Simple Desktop Display Manager) is the recommended Display Manager for LXQt, so I encourage you to switch. The procedure is not difficult. Here's how to accomplish that.
From the Main menu, go to Preferences > Admin > Configure Your Computer > Configure Login Manager:

Type in the root user's password and click the OK button. Change GDM to SDDM by clicking its radio button. Click the OK button.

Reboot your PC for this change to take effect.
Elarun, Maldives and Maya SDDM Themes
The easiest SDDM themes to use are Elarun, Maldives and Maya. They are the default themes provided by SDDM and require minimal configuration because they do not support avatars.
Daniel wrote a utility program, called "Configure SDDM," with a simple GUI to manage your /etc/sddm.conf file. For demonstration purposes, let's change the theme to Maya:
From the Main menu, go to Preferences > Admin > Configure SDDM.

Type the root password, and click the OK button:

From the "Current" drop-down menu, choose "maya". Uncheck / deselect the "Enable Avatars" option:

Click on the Save button.
To apply your changes, a pop-up window will appear. Click on its "Run" button:

Close the confirmation pop-up window ("All settings are done") by clicking on the OK button.

Log out of your session to see the theme change.

The above procedure is identical for using the Elarun and Maldives themes. I included screenshots of them below. (I apologize for the poor image quality; these photos were taken with my smartphone camera).
Elarun SDDM theme:

Maldives SDDM theme:

PCLOS-LXQt SDDM Theme
The pclos-lxqt theme allows you to have an avatar; it looks nicer, in my opinion, but requires a few extra configuration steps.
Before beginning, your avatar / icon must be placed in the /usr/share/sddm/faces directory and must follow the naming convention " username.face.icon ." If you wish to use one of the "stock" PCLinuxOS avatars, they are found in the /usr/share/faces directory.
In my case, I chose a CrystalXP Tux-as-Wizard icon which I had saved in my Downloads folder.
I first renamed the file, using the command $ mv tux-wizard-icon.jpg david.face.icon
Next, I became root user, changed directory to my Downloads folder and copied the avatar to the appropriate sddm folder:
[root@localhost ~]# cd /home/david/Downloads
[root@localhost Downloads]# cp david.face.icon /usr/share/sddm/faces
After these preliminary steps have been completed, Start the Configure SDDM utility program by typing the root password, and clicking the OK button. Check (tick) the "Enable Avatars" option, the from the "Current" drop-down menu, choose "pclos-lxqt" as the theme.

Click on the Save button. Click on the Run button in the pop-up window to execute your proposed changes:

Close the confirmation pop-up window ("All settings are done") by clicking on the OK button.

Log out of your session to view the new pclos-lxqt theme.

Note: The Configure SDDM utility has a welcome feature: a Preview button. Clicking on it will trigger a preview of the SDDM screen. After several seconds, a pop-up window appears with a button to exit the preview mode.

Editor's Note: This article will be continued in Part 2 next month.
![]()



A 78 RPM Record Treasure Trove
by Paul Arnote (parnote)
Some of my fondest memories from my childhood involve spending an afternoon listening to little yellow 78 rpm records that we had as kids. They all had child themed songs or stories on them, with titles like Tubby the Tuba, the Pokey Little Puppy, and How Much Is That Doggie In The Window.
Of course, they weren't all yellow, but that's the color that stands out in my mind (probably because yellow is my favorite color). The yellow ones were from Golden Records. But there were also red ones, typically branded Peter Pan Records. I remember other records in assorted colors. I even remember the odd black 45 rpm records mixed in, that required the adapter (called a spider) in the larger hole to be able to be played. Occasionally, we'd find child records "embedded" on the back of a box of cereal, like Cap'n Crunch or Wheaties. We played those, too, after carefully cutting out the back of the cereal box (only after we had eaten the cereal, of course). Me and my siblings would sometimes scuffle over who was going to get to play the cereal box record first.

Photo from Etsy seller, EpicVintageTreasures
We played them on a small child size phonograph that was capable of playing records at 78, 45, and 33 1/3 rpms. We had a lot of these records. They were very popular in the 1950s and 1960s. We'd save up our allowance to be able to buy more of these records periodically. One of the stores my parents frequently shopped at had a large section of these records, and we always visited it every time we went to that particular store. From there, we would purchase new ones for prices between 29 and 69 cents each.
It seems that these child focused phonograph records have become quite the collector's item. Of course, this happens with all sorts of things once they aren't produced any more. Depending on condition, the seller, the titles offered for sale, and a host of other assorted criteria, they now routinely sell for as much as $100 for a 29 item lot. Others sell on eBay for mostly between $6 and $12 per copy. The most expensive one I could find is a super rare 12" Vogue Picture Record (78rpm) - A Trip To Slumberland, Part 1 & 2, that usually sells for $2,200 to $2,500 whenever it does show up for sale. The guy that had it listed for sale was offering it at a bargain $1,800.
Meanwhile, when I visited the home of my childhood best friend, his mom had an O-L-D crank-up Victrola record player. It didn't need to be plugged in. It just needed to be cranked up. We'd spend afternoons playing old 78 rpm records from the early 1900s. Those old records looked way different than any other records we were familiar with. They were 12 inches in diameter, and THICK. Some were as thick as 1/4". His mom had a "collection" of a few dozen of those old records, stored in a cabinet below the Victrola. Some of the songs were pretty good, while others made us laugh hysterically because they were just horribly bad. We're talking about the mid 1960s here.
Fast forward to the early 1980s, and the emergence of CD audio (formally called Red Book Audio, co-developed by Philips and Sony in 1980). The first audio CD was offered for sale to the public for the first time in 1982. The crystal clear, digital sound of CDs, free from pops, scratches and skips, caused most in the music industry to sound the death toll for phonograph records. And, for a while, they were right. Phonograph records became more scarce than hen's teeth for a very long time. You can read more about CD audio's reign of the audio market here.
CDs enjoyed market dominance for about 20 to 30 years, until they were replaced with digital audio files and streaming. Today, digital audio files and streaming rule the day. Even though CDs are still around, their market share is a mere shadow of what it once was.
However, in the 2010s and early 2020s, phonograph records started making a comeback. Initially, that comeback was fueled by audiophiles, yearning for the "old fashioned" way of listening to recordings, complete with their pops, crackles and skips. Later generations of audio enthusiasts further fueled the resurgence of phonograph records, yearning for the audio that their parents and grandparents listened to, even with its limitations and drawbacks. More recently, and for the same reasons, cassette tapes have also started a resurgence in popularity.
A Collection Of & For The Ages

So, you may be wondering exactly where this whole background story is going. Reminiscing about those days of my childhood, I started to wonder if anyone had taken the time to digitize their collections of these child records. I would love to be able to share them with my own kids. So far, I've not found any of those records that have been digitized and made available on the internet (but I'm not finished looking yet, either). But, that is how I found out about people collecting these items. It's also how I found, quite by accident, a whole collection of old 78 rpm records that have been digitized for posterity.
Thanks to the Internet Archive, over 385,000 of these 78 rpm records have been digitized in the "The Great 78 Project" collection, digitized with the help of George Blood, L.P.. The oldest one I've personally found is from the 1920s. I've personally found music in the collection all the way up into at least the 1970s. The most represented decades appear to be the 1950s, followed by the 1940s, from what I've found. Titles from the very early 1900s and even the late 1800s are listed in the search filters, with 2013 being the latest date in the search filters.
In this collection, I've discovered music from the U.S., France, Germany, Mexico, Brazil, Sweden, Canada, the U.K., Japan, and many other countries. As far as I can tell, most of the titles are from the U.S.
Here's some of the artists I've stumbled across in the collection (in no particular order): Elvis Presley, Bill Haley and His Comets, Buddy Holly, Doris Day, Cab Calloway, Louis Armstrong, Jerry Lee Lewis, Guy Lombardo, Bing Crosby, Glenn Miller, Woody Guthrie, Xavier Cugat, Dorothy Lamour, Frank Sinatra, Artur Rubenstein, Billie Holiday, Hank Williams, The Platters, Ray Charles, Harry Belafonte, Duke Ellington, Lead Belly, Judy Garland, Rosemary Clooney, Gene Kelly, and many, many more.

There are literally tons of Christmas music in the collection, like "Rudolph The Red Nosed Reindeer," "Santa Claus Is Coming To Town," "White Christmas," and many more others than I can even begin to list here. Some of the other titles I've run across include "Jailhouse Rock," "Love Me Tender," "Minnie The Moocher," "Que Sera Sera," "Banana Boat," "Great Balls Of Fire," "Shake, Rattle & Roll," "House of the Rising Sun," and many, many more.
The genres of music cover classical, country and western, swing, Big Band, rock, pop, instrumentals, marches, Christmas, ragtime, blues, jazz, and just about every other genre you can imagine.
The vast majority of the collection is recorded using different size styluses, so there are multiple versions of each song presented. Some are even "lightly restored," where a lot of the pops, crackles and background hiss are eliminated or minimized. Those selections are marked "Restored," and I'll be the first to tell you that they sound really good. Of course, you can see for yourself, by listening to (or downloading) the "unrestored" versions.
Or ... You Could Record Your Own Collection
There's a strong possibility that some of you reading this article have your own collection of 78 rpm records at home. Or, you might know someone who has a collection of 78 rpm records. If so, it might be time to digitize those collections.
Yes, you can still buy phonograph players that playback records recorded at 78 rpms. In fact, I was a bit surprised to see so many offered for sale on Amazon. Prices start at around $45 (U.S. dollars) for self-contained players, complete with their own built-in speakers that just playback phonographs. For about $20 more, you can get one with retro styling that also has Bluetooth capabilities and the abilities to record your vinyl records as either MP3 or WAV audio files, allowing you to archive your vinyl phonographs as digital recordings. Others record either MP3 or WAV audio files (one or the other), and one even has a cassette player and FM radio built in. On the model that plays cassette tapes, you can also digitize your cassette tape collection (hello 70s and 80s homebrew mix-tapes?).
Many of these players allow using USB thumb drives and/or SD memory cards to record and store (archive) your audio recordings on. Thus, you then can manually transfer your recorded vinyl to your computer by just plugging either the USB thumb drive or the SD memory card into your computer and copy the files over to your computer's drive. Bluetooth allows you to connect wireless speakers or headphones/earbuds to the unit, or to stream music from your streaming devices to the player. The really nice thing about using these players is that there is nothing to install on your computer, other than the sound editing software (Audacity, anyone?) that you may want to use to clean up your recordings. The recording of your files is handled completely by the player.
Summary
Just about anyone should be able to find music that fits their musical tastes in this collection. The collection, albeit far from complete, is vast and varied. And, best of all, it's free.


PCLinuxOS Recipe Corner Bonus: Air-Fryer Beef Turnovers
Air-Fryer Beef Turnovers

Make 1 dozen
INGREDIENTS:
1 pound ground beef
1 medium onion, chopped
1 jar (16 ounces) sauerkraut, rinsed, drained and chopped
1 cup shredded Swiss cheese
3 tubes (8 ounces each) refrigerated crescent rolls
DIRECTIONS:
In a large skillet, cook beef and onion over medium heat until meat is no longer pink, 5-7 minutes; crumble meat; drain. Add sauerkraut and cheese.
Preheat the air fryer to 350F. Unroll crescent roll dough and separate into rectangles; pinch seams to seal. Place 1/2 cup beef mixture in the center of each rectangle. Bring corners to the center and pinch to seal. In batches, place turnovers in a single layer in a greased air fryer. Cook until golden brown, 12-15 minutes.
TIPS:
Cooking times vary dramatically between brands of air fryers. As a result, we give wider than normal ranges on suggested cook times. Begin checking at the first time listed and adjust as needed.
NUTRITION:
Serving size 2 turnovers
Calories: 634 Carbs: 54g Sodium: 1426mg Fiber: 2g Protein: 27g
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